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ImageJ software as an alternative method for estimating leaf area in oats
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Abstract
The aim of this study was to compare two methods of estimating leaf area (leaf area meter LI-COR 3100 and 
ImageJ software) in oats. Renascem black oats and UTF Iguaçu white oats cultivars were evaluated. All the leaves 
of one plant per plot, with six repetitions, were evaluated every seven days to obtain five assessments for each 
cultivar. The leaves were identified and fixed on a white A4 sheet of paper with an indication of a known area (45 
cm²), photographed and evaluated using a leaf area meter (LI-3100 - LI-COR). Leaf area was then estimated using 
ImageJ software. Estimates were obtained for standard deviation and coefficient of variation, and a simple linear 
regression equation was estimated based on the two estimation methods. Mean variances were tested using the 
‘F’-test and the means compared by the ‘t’-test. There was no difference between the leaf areas found by both 
methods. In addition, they were highly correlated, and variances were homogeneous. We concluded that ImageJ 
software can be used instead of the leaf area meter on the two oat cultivars evaluated.
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Resumen
El objetivo del estudio fue comparar dos métodos (Integrador del área foliar LI-COR 3100 y el software ImageJ) 
para estimar el área foliar en el cultivo de avena (Avena sativa L.). Para el efecto se evaluaron dos variedades de 
avena, una negra (Renascem) y otra blanca (UTF Iguaçu). Se utilizaron seis repeticiones (diseño completamente 
aleatorio), con la recolección de todas las hojas de una planta seleccionada al azar por parcela cada 7 días y un 
total de cinco evaluaciones para cada variedad. Las hojas cosechadas fueron identificadas y fijadas sobre una hoja 
A4 blanca, con una marca de área conocida (45 cm²), fotografiadas y evaluadas utilizando el integrador de área 
de la hoja (medidor de área LI3100 - LI-COR). Posteriormente en las mismas hojas se midieron las áreas foliares 
utilizando el software ImageJ. Con los datos obtenidos en cada método se calcularon la desviación estándar, el 
coeficiente de variación, y la ecuación de regresión lineal simple. Las varianzas de los valores se probaron con 
la prueba ‘F’ y las medias se compararon con la prueba ‘t’. Al considerar todas las hojas evaluadas por ambos 
métodos, se encontró que las áreas de las hojas no difieren entre ellas cuando se comparan con los métodos 
propuestos. Además, tienen altas correlaciones y las variaciones son homogéneas. Como conclusiones, se encontró 
que el método que usa el software ImageJ puede ser utilizado para reemplazar el integrador del área de la hoja 
para las variedades de avena evaluados.
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Introduction

Leaf area index (LAI) values are used to determine 
sowing time (so that the highest leaf area 
coincides with the highest availability of solar 
radiation), when to apply pesticides, plant 
spacing, fertilization (Favarin et al., 2002), weed 
control, water use, soil erosion (Wilhelm et al., 
2000). These factors directly impact growth and 
development parameters in agricultural crops 
(Benincasa, 1988; Bignami and Rossini, 1996).

Various methods are used to estimate LAI 
(Kvet and Marsall, 1971), and they are destructive 
and non-destructive. In some cases, destructive 
methods impose limitations on the number of 
treatment effects that can be evaluated, especially 
where only a limited number of plants is available 
(Lopes et al., 2007). Some methods and examples 
of how they are applied are cited in the literature, 
including the leaf disk method (Lopes et al., 2007), 
automatic planimeter (Mielke et al., 1995), leaf 
weight (Monteiro et al., 2005) and the gravimetric 
method (Norman and Campbell, 1989). Non-
destructive methods include those that estimate 
leaf dimensions (Partelli et al., 2006), leaf areas 
using regression models (Moreira-Filho et al., 
2007; Coelho-Filho et al., 2005) and those that 
use digital images and software for analysis. 
Methods involving the use of digital images can 
be destructive (if the leaves are removed from 
the plant) or non-destructive (if digital images 
of the leaves are captured without removal 
from the plant). Some software packages can be 
downloaded free of charge, but this does not apply 
to the leaf area meter (standard method), which 
entails importing equipment at high cost, which 
can be an insurmountable barrier to conducting 
research projects. The use of digital imaging 
and dedicated software has been documented 
for various crops, including acid lime (SIARCS, 
Coelho-Filho et al., 2005); coffee (SIARCS, 
Tavares-Júnior et al., 2002); nasturtium (Sigma 
Scan Pro v. 5.0, Lopes et al., 2007) and soybean 
(Spring, Adami et al., 2007).

Few studies have been conducted on forage 
crops, resulting in a gap in our knowledge of 
this field. Therefore, the aim of this study was 
to perform a comparison, using white and black 
oats, of two methods: (1) leaf areas measured 
based on digital images processed using 
ImageJ software, and (2) the standard method 
of estimating leaf area using a leaf area meter 
(LI-COR 3100).

Material and methods
The trial was carried out in the experimental 
greenhouse at the Pato Branco Campus of the 
Parana Federal Technological University (UTFPR, 
PB) in Pato Branco, Parana, Brazil. Two oat 
genotypes were used: white oat cultivar UTF 
Iguaçu and black oat cultivar Renascem. Seeds 
were sown manually on April 2, 2008, in 2 x 
4-meter plots, at a density of 300 viable seeds 
per square meter. Leaf area was estimated in the 
Biochemistry and Plant Physiology laboratory at 
UTFPR-PB using the free software ImageJ and 
also using a leaf area meter (LI-COR 3100, 1996).

Five evaluations were carried out, the first at 
twenty-seven days after sowing and subsequently 
every seven days on the following dates: April 
29 (beginning of tillering); May 6 (full tillering); 
May 13 (beginning of elongation); May 20 (stem 
elongation) and May 27 (end of elongation). The 
variable estimated by both methods was leaf area 
per plant. On each evaluation date, one plant was 
sampled from each experimental unit, giving a 
total of six plants per treatment. 

After collecting the plants, the leaves were 
removed (destruction that can be avoided using 
ImageJ) and identified, placing the leaf blades 
on a sheet of A4 paper bearing a totally black 
rectangle 3 x 15 cm (45 cm²) used to calibrate 
the software. All leaves were then photographed 
using a digital camera (7.2-megapixel resolution), 
and the photos processed to obtain the area using 
ImageJ software. The average distance between 
camera and leaf was 50 cm.

Instructions for evaluating leaf area: (1) take a 
photograph of the leaf with the camera horizontal, 
the leaf totally flat on the worksurface and with a 
scale; (2) open the image in ImageJ: File > Open; 
(3) remove superfluous objects: mage > Crop; 
(4) set the scale: Analyze > Set Scale; (5) set the 
contrast: Image > Type > 8-Bite Image > Adjust 
> Threshold; (6) Compute the area: Analyze > 
Analyze Particles. After photographic processing, 
the leaves were evaluated using the leaf area 
meter (LI-COR LI 3100, 1996).

The experiment was carried out in a completely 
randomized design with six replications. Statistical 
analysis was carried out in Excel® using equations 
to compute the number of leaves evaluated (N), 
arithmetic mean, standard deviation (SD), value of 
the intercept and regression equation slope for full 
and reduced regression, the correlation coefficient 
(r) and the determination coefficient (R2). Tabular 
and computed values were also compared using 
the ‘t’- and ‘F’-tests and coefficient of variation, 
and the equation parameters tested at 1% error 
probability (Yamane, 1969). 

ImageJ software as an alternative method 
for estimating leaf area in oats
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Results and discussion
The total number of leaves evaluated for black 
oats was 224 and for white oats 258. There was 
homogeneity of variances for all evaluations of the 
two cultivars (F-test) (Yamane, 1969). In addition, 
the estimated means for leaf area did not differ for 
most evaluations (t-test). A significant difference 
was detected only in the first black oat and in 
the second white oat evaluations. This may have 
been due to an insufficient number of leaves (not 
very likely) or the natural roughness of the leaves 
(more likely, since the leaf area meter needs to be 
pressed against the leaf keeping it flat, whereas to 
take the photos their natural surface roughness is 
unaffected). On evaluating the entire set of leaves 
for both oat cultivars, no significant difference 
was found between the methods tested.

In terms of the coefficient of variation, despite 
the high values obtained, the magnitudes are 
similar when methods tested are compared for the 
same evaluation date. For the black oat cultivar, 
the coefficient of variation ranged from 44.3 to 
71.6 (Table 1), and for the white oat cultivar from 
31.8 to 79.2 (Table 2). These high values can be 
ascribed to the variability in the size of oat leaves 
under each of the methods tested.

Most of the values for the Pearson correlation 
coefficient and determination coefficient in 
the equation were higher than 0.90 (P < 0.01), 
denoting a good data fit for linear regression. 
Although some values ranged from 0.62 to 0.89, 
all were significant (Tables 1 and 2). On testing 
the parameter in the first-degree equation, it 
was found that the computed values were higher 
than the tabular values, denoting a significant 
fit for the parameter (P < 0.01). Non-rejection of 
the assumptions relating to the F- and t-tests 
indicates that the variances are homogeneous, 
even though the means of the values did not 
differ from one another, showing that both 
methods behave in the same way with regard 
to the estimated variances and means for the 
treatments.

The morphology of the leaves contributed in 
practice to the efficiency of the methods, since 
the leaves are relatively smooth and unifoliate, 
preventing superimposition and reducing 
estimation error problems. Leaf handling 
problems can impair the comparative accuracy 
of the estimates made, inducing errors and 
introducing differences not due inherently to the 
individual methods used. When using the leaf 
area meter, the operator should be aware of some 
operating errors. When passing the leaf through 

the Meter, it must not be folded or superimposed, 
which could lead to underestimating leaf area. 
The same applies to digital image capture; if 
photograph quality is poor, it should be retaken 
or even discarded. This can be caused by the 
angle of the photograph.

Some studies recommend using ImageJ in the 
agrarian sciences. This is the case in Gomes-Filho 
et al. (2006), in a study validating the scoring 
method for quantifying physiological blemishes 
in papaya. ImageJ can be used to speeds up fruit 
classification and standardization for commercial 
purposes. Sequential evaluations at different 
times can result in different states of roughness, 
inducing significant variability in the leaves, but 
this phenomenon was not observed for oat leaves. 

Using the t-test, it was observed that the 
means of the leaf area estimates for both methods 
showed no significant differences, indicating that 
both methods provide valid leaf area estimates. 
Furthermore, it also indicates that morphological 
characteristics and leaf handling did not affect 
leaf area estimates. The leaf handling involved 
in using the leaf area meter on species with 
leaflets, such as soybean and common bean, 
requires care to avoid superimposition and 
consequent underestimation of leaf area. Using 
ImageJ software, this can be verified directly on 
the image which can be discarded if not deemed 
adequate. In addition, this method can be used 
non-destructively by capturing the digital image 
directly from the plant, without removing the 
leaves.

Lino et al. (2008) report that ImageJ is fairly 
widely used in medical practices and research 
because the software is versatile and can be 
accurately used in various operating systems 
(Windows, Linux and Mac/Os). ImageJ is also 
open source so that the classification system can 
be adapted to recognize shape, volume, color and 
in some cases impairment. These authors used 
ImageJ to classify limes and tomatoes, concluding 
that limes can be classified according to size and 
tomatoes according to color. 

Estimating leaf area in common bean, Jesus-
Junior et al. (2001) compared two methods: using 
the LAI2000 leaf area meter and measuring the 
leaf’s central axis. The correlation between the 
two methods was found to be higher than 0.97. 
Comparing this to our findings, the correlation 
and determination coefficients were, for the 
most part, higher than 0.90 and all results were 
significant at 1% error probability. Comparing 
non-destructive (alternative) methods with 
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Table 1. Leaf area estimate statistics (cm2) for black oats using a leaf area meter (LI-COR 3100) and ImageJ software*. UTFPR (2008).

Parameter / evaluation 1st (Apr 29) 2nd (May 6) 3rd (May 13)

ImageJ Meter ImageJ Meter ImageJ Meter

NL 34 — 36 — 59 —

Mean (cm2) 2.21 2.68 5.74 6.10 9.47 9.43

SD 1.0082 1.1937 2.9180 3.1956 5.9079 6.1083

Intercept (B0) 0.179936847 — 0.368769502 — 0.223246942 —

Slope(B1) 1.12844817 — 0.998713058 — 0.971635834 —

Correl (r) 0.95 ** 0.91 ** 0.94 **

Deter Coeff. (r2) 0.91 ** 0.83 ** 0.88 **

B0=0 1.19608986821 — 1.05008495441 — 0.98868246290 —

Tcal 17.8082 — 12.9597 — 20.7541 —

Ttab 2.7385 — 2.7284 — 2.6649 —

F-test (P<0.01) 0.3366868256 Ns 0.5936823060 ns 0.8002761552 ns

T-test (P<0.01) 0.0438714465 ** 0.3089472081 ns 0.4836315297 ns

CV% 45.61 44.54 50.83 52.38 62.38 64.77

Equation LAI=1.1960898682093*IJ LAI=1.0500849544113*IJ LAI=0.9886824628982*IJ

Parameter / evaluation 4th (May 20) 5th (May 27) Overall evaluation

ImageJ Meter ImageJ Meter ImageJ Meter

NL 52 — 43 — 224 —

Mean (cm2) 13.73 13.92 16.01 15.64 10.02 10.11

SD 6.0881 6.2836 7.3376 7.2245 7.1872 7.1283

Intercept (B0) 0.332280249 — -0.024841509 — 0.401015109 —

Slope (B1) 0.989573809 — 0.978402363 — 0.968879711 —

Correl (r ) 0.96 ** 0.99 ** 0.98 **

Deter Coeff. (r2) 0.92 ** 0.99 ** 0.95 **

B0=0 1.00985748922 — 0.97711502070 — 0.99534898507 —

Tcal 23.8607 — 56.8342 — 68.0850 —

Ttab 2.6778 — 2.7012 — 2.5982 —

F-test (P<0.01) 0.8222871809 ns 0.9203189076 ns 0.9023520081 ns

T-test (P<0.01) 0.4382346934 ns 0.4069844226 ns 0.4474974561 ns

CV% 44.34 45.14 45.57 46.19 71.72 70.50

Equation LAI=1.0098574892180*IJ LAI=0.9771150206952*IJ LAI=0.9953489850664*IJ

*number of leaves (NL), standard deviation (SD), mean, full equation intercept (Intercept (B0), Slope (B1), Pearson correlation coefficient (r), determination coefficient 
(r2), straight line slope coefficient where B0=0 (B0=0), T calculated (Tcal) and T tabulated (Ttab) statistical value, F- and t-test probability (P<0.01), percentage coefficient 
of variation (CV%) and reduced equation.  ns and ** = not significant and significant at 1% probability.

destructive (conventional) methods for estimating 
leaf area, Tewolde et al. (2005) found the 
correlation between the two methods to be higher 
than 0.66.

The results in Figures 1 and 2 show that 
ImageJ produced results similar to those 
obtained using the leaf area meter. Lino et al. 
(2008) reported that the accuracy obtained using 
electronic systems was within one gram for fruit 
classification by weight and one millimeter for 
classification by diameter. The authors concluded 
that the methods tested were influenced by 
the row spacing, since they involved placing 
the equipment on the soil between rows. For 

this reason, the authors recommended taking 
precautions to minimize variations in the values 
obtained compared to the conventional method. 

Comparing three methods for estimating leaf 
area in palisade grass, Sbrissia and Silva (2008) 
detected variations for height and time of year 
for the direct, destructive method, and did not 
recommend the use of a meter for collecting LAI 
data for simulation purposes. Furthermore, in 
this case the determination coefficient for the 
methods tested ranged from 0.22 to 0.859. An 
efficient alternative for estimating leaf area (using 
ImageJ) was implemented in cucumber and 
tomato (Blanco and Folegatti, 2003) and saved on 
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Table 2. Leaf area estimate statistics (cm2) for white oats using a leaf area meter (LI-COR 3100) and ImageJ software*. UTFPR (2008).

Parameter / evaluation 1st (Apr 29) 2nd (May 6) 3rd (May 13)

ImageJ Meter ImageJ Meter ImageJ Meter

NL 28 35 44

Mean (cm2) 7.3066 5.9704 4.55543 5.69627 5.74386 6.29068181

SD 5.12 4.73 1.6127 1.90383 2.07123 2.00336854

Intercept (B0) 1.3663 1.44626 1.06140

Slope (B1) 1.17533 0.93295 0.91041

Correl (r ) 0.99 ** 0.80 ** 0.94 **

Deter Coeff. (r2) 0.99 ** 0.63 ** 0.89 **

B0=0 0.8526604 1.21598 1.07436

Tcal 47.2449 7.40911 18.0629

Ttab 2.7787 2.7333 2.6981

F-test (P<0.01) 0.419180 ns 0.33783 ns 0.82808 ns

T-test (P<0.01) 0.429041 ns 0.00431 ** 0.10576 ns

CV% 70.07 79.22 35.40 33.42 36.06 31.84

Equation LAI = 0.8526604 * IJ LAI = 1.215978305 * IJ LAI = 1.07436576 * IJ

Parameter / evaluation 4th (May 20) 5th (May 27) Overall evaluation

ImageJ Meter ImageJ Meter ImageJ Meter

NL 48 98 258

Mean (cm2) 7.52354 7.484 10.172 10.3800 7.37105 7.6156

SD 3.04699 3.162 4.25618 4.35054 3.96322 4.02841

Intercept (B0) -0.25116 0.31061 0.35676

Slope(B1) 1.02818 0.98989 0.98478

Correl (r) 0.99 ** 0.96 ** 0.97 **

Deter Coeff. (r2) 0.98 ** 0.94 ** 0.94 **

B0=0 0.99942 1.01592 1.02236

Tcal 49.8356 38.0574 62.5933

Ttab 2.68701 2.62801 2.59517

F-test (P<0.01) 0.80097 Ns 0.82945 ns 0.79387 ns

T-test (P<0.01) 0.47545 ns 0.36787 ns 0.24360 ns

CV% 40.50 42.25 41.84 41.91 53.77 52.90

Equation LAI = 0.99942 * IJ LAI = 1.01591 * IJ LAI = 1.02236* IJ

*number of leaves (NL), standard deviation (SD), mean, full equation intercept (Intercept (B0)), Slope (B1), Pearson correlation coefficient (r), determination coefficient 
(r2), straight line slope coefficient where B0=0 (B0=0), T calculated (Tcal) and T tabulated (Ttab) statistical value, F- and t-test probability (p<0.01), percentage coefficient 
of variation (CV%) and reduced equation.

ns and ** = not significant and significant at 1% probability.

both time and labor. Along similar lines, Ramirez 
and Zullo Jr. (2010) analyzed the leaf area index 
parameter in a coffee crop using Quickbird 
satellite orbital images and concluded that the 
use of high-resolution imaging is a promising 
method for determining LAI.

Advances in technology mean that digital 
imaging techniques can now be used for 
assessing plant leaf area. They are easy to use, 
fast, economical and non-destructive, and quality 
research can be conducted at lower cost, lower 
labor intensity and to an accuracy equivalent to 

methods involving the use of a leaf area meter. 
The data presented herein show that estimating 
leaf area in white and black oat crops can be done 
simply and produce quality results compatible 
with the research objectives.

Conclusion
Digital imaging and ImageJ software processing 
can be used in place of a leaf area meter in 
white and black oat crops without impairing the 
accuracy of the results.

Acta Agronómica. 69 (3) 2020, p 162-169



167

Figure 1. Regression analysis of black oat leaf area as a function of the five evaluation times: Apr 29/2008 (A); May 6/2008 (B); May 13/2008 (C); May 20/2008 (D); May 27/2008 (E) and grouping all leaf area data (F) for the Renascem 
cultivar estimated by the leaf area meter and IMAGEJ® software. UTFPR (2008)

ImageJ software as an alternative method 
for estimating leaf area in oats



168

Figure 2. Regression analysis of oat leaf area as a function of the five evaluation times: Apr 29/2008 (A); May 6/2008 (B); May 13/2008 (C); May 20/2008 (D); May 27/2008 (E) and grouping all leaf area data (F) for the white oat cultivar UTF 
Iguaçú estimated by the leaf area meter and IMAGEJ® software. UTFPR (2008)
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